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1 Guide to the TLX-TCM Configuration Manager 
Manual 

Function  Section to Read Details 

Introduction 
(Must Do) 

→ Product 
Specifications (page 
7) 

This section gives the customer an overview of 
the TermLinx Terminal Management System, 
including features and benefits as well as 
functional specifications.  

   
Configuration 
(Must Do) 

→ Configuring 
TermLinx (page 9) 
Configuring the 
TermLinx AccuLoad 
Interface (page 43) 

These sections contain information about 
configuring the batch controllers and setting up 
sites.  

   
Reference 
(Must Do) 

→ TermLinx PLC 
Ladder Logic 
Interface (page 47) 

This section contains detailed ladder logic 
information.  

    
License, Warranty, and 
Support 
Index 

→ License, Warranty 
and Support (page 
55) 
 

This section contains License, Warranty, and 
Support information.  
Index of chapters. 
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2 Product Specifications 

In This Chapter 

 Functional Specifications.........................................................................8 

TermLinx™ is an innovative Terminal Management System (TMS) designed for 
the Microsoft™ Windows™ XP platform. It meets the growing industry demand 
for seamless database connectivity to the corporate host management systems. 
At the same time, it has been designed for cost effective stand-alone operation. 
One of its outstanding features is its use of non-proprietary, globally available 
hardware and software platforms, which make it relatively easy to support. 
TermLinx integrates tightly with Rockwell Automation™ PLCs for its system 
functions (with a direct data link) and communication interface to the AccuLoad™ 
Batch Controllers and Set-Stop unit. Because the same PLC can be used for the 
overall terminal control, TermLinx eliminates the need for additional hardware for 
station control. 
 Easy to use Touch Screen interface 
 Display status and alarm information in your HMI 
 Uses ORACLE™ database 
 Patented Water Cut Technology 
 Field Configurable 
 Field Expandable 

TermLinx provides a well-defined data exchange protocol for central enterprise 
and corporate wide business management host computer systems. It allows such 
a system to operate any number of remote TermLinx sites through Ethernet-
based TCP/IP LAN/WAN systems on a 7/24 basis. 

Benefits include: 
 Fewer hardware "boxes" to reduce failures and lower initial system and 

maintenance costs 
 Gate Access (This feature currently applies only to OPACTS users, but is 

planned for an upcoming TermLinx release)  
 TermLinx Configuration Manager, included 
 High-level, user-friendly graphical touch screen for truckers  
 TermLinx Database Manager, included for: 

o Database editing and maintenance 
o Report generation 
o Database backup in "csv" format for importing into other applications 

 TermLinx Configuration Manager (TCM) to facilitate: 
o Loading/offloading island configuration 
o Product blend control and configuration 
o PLC Data File Mapping and hard copy documentation 
o Automatic PLC Data File tag generation 
o Extensive operating database options: 
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• Validation & Lockout by: Driver, Contract #, Time and Date Window, Product 
Volume, Driver License Expiration, Carrier Insurance Expiration etc. 

• Remote on-line maintenance of complete database from corporate 
headquarters 

• Automatic purging of the transaction database based on a configurable time 
window  

 Small installation, short time from installation to implementation 
 Scalable for small to large installations  

 

2.1 Functional Specifications 

 Operating system: Microsoft Windows XP 
 Controller: Industrial grade non-proprietary platform with global presence 

(Rockwell Automation PLC) 
 TermLinx, Database Server, System Computer: Industrial grade touch 

screen Pentium™ PC 
 Open System Architecture: ODBC & ACTIVE-X Object module integrated 

into an HMI Container (Rockwell Software™ RSView32™, Wonderware™, 
and so on.) 

 Well established client/server type relational database engine: ORACLE 
XE 10g 

 Flexible and expandable database tables to accommodate wide range 
operating data file structures 

 Ethernet, TCP/IP, LAN/WAN, and PPP connectivity  
 Corporate Database access to Multiple TermLinx applications at remote 

locations 
 Tightly integrated with terminal automation PLC system 
 Current Transaction data (audit trail) written to PLC data file for HMI or PLC 

host using RSLinx  
 Communication interfaces for Set-Stop units (AccuLoad) 
 Option for using powerful internal functions for replacing external Set-Stop 

units for product volume measurement and batch control using ProSoft's in-
chassis flow computer  
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3 Configuring TermLinx 

In This Chapter 

 Using TermLinx Configuration Manager ..................................................9 

 Configurator Responsibilities.................................................................10 

 Creating Formal Documents..................................................................11 

 Starting TermLinx Configuration Manager.............................................11 

 Starting a New Project...........................................................................11 

 Loading a Project ..................................................................................12 

 Site Configuration..................................................................................13 

 Saving Your Configuration.....................................................................30 

 Creating the PLC Database Tag File.....................................................31 

 View Configuration Script Dialog Box....................................................31 

 Installing TermLinx Configuration Files .................................................33 

 TermLinx Instance Dialog Box...............................................................33 

 
 

3.1 Using TermLinx Configuration Manager 

TermLinx Configuration Manager is an application that simplifies the task of 
managing the configuration files which control how your TermLinx system 
operates. TermLinx Configuration Manager is designed for computers running 
Microsoft Windows XP.  

Note: TermLinx Configuration Manager is not supported on computers running earlier versions of 
Windows. 

The TermLinx Server is configured with configuration files that you create using 
TermLinx Configuration Manager. A configuration file is called a Project. One 
project is created for each site by configuring items in a Site Configuration dialog 
box, and then configuring gates, islands, mapping, and finally, saving the project 
with a site-specific name. A Project runs on the TermLinx Server only after you 
save and download the project file to the Server. 
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3.2 Configurator Responsibilities 

Programming 
The Configurator must program ladder logic in the PLC for TermLinx, for a 
minimum of two rungs per bay, and is responsible for programming the PLC, 
Flow Computer, HMI, and the batch controller.  

If the site desires integration with external systems, such as Tank Gauging or 
Inventory Management Systems, it is possible at either the site level or the 
corporate level. This is outside the scope of TermLinx, but the SI can make use 
of the TermLinx data and setup the PLC logic for direct interaction of it with such 
external systems.  

Optionally, implement PLC logic to terminate transactions in progress in the 
event of a power failure and restore. Refer to TermLinx PLC Ladder Logic 
Interface (page 47) in this manual for more information on programming. 

Site Configuration  
The Configurator is responsible for configuring the TermLinx site using TermLinx 
Configuration Manager (TCM) and making minor adjustments as required. This is 
not a day-to-day function, but is necessary only when physical changes to the 
site are made, such as the addition of a new Bay. It is necessary to set up the 
site, islands (bays) per site, and island information in TCM.  

It is very important that the site be configured in coordination with your corporate 
assignment of Product codes in the database, especially when multiple sites are 
to be administered from a central location. The Configurator must keep this in 
mind when preparing the PLC data files. The Configurator also needs to assign 
PLC files to the site and each island. Part of the island configuration is setting the 
accumulator characteristics, which relate to the type of batch controller being 
used.  

TermLinx Configuration Manager also allows physical island mapping to 
associate two TermLinx logical single-mode islands with a single, dual-mode, 
physical island. Thus, one island, if capable, can be setup as both loading and 
unloading. The supporting PLC ladder must be present to ensure mutual 
exclusivity of mode. Refer to Site Configuration (page 13) in this manual for more 
information on designing and implementing your site.  

Database Population  
At site setup time, the Configurator works with the Account Administrator to 
perform initial population of the database. Refer to the TermLinx Database 
Manager for more information on database configuration. 
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3.3 Creating Formal Documents 

TermLinx uses Crystal Reports runtime to print each formal document. The data 
comes from the Temporary Database. Upon receiving the signal to issue the 
document, it prints using the Crystal Report “report format” files that specify 
completely the contents of the relevant document. The documents are printed 
using printers connected to parallel ports on the Host; one port is for loading 
transactions and the other for unloading transactions, and where suitable both 
loading and unloading transactions may use the same port.  

There are sample BOL and BOU reports provided with TermLinx. Use Crystal 
Reports to customize them. See Setting Formal Report Printing and File Paths 
(page 37) for details.  

The Projects folder contains editable copies of the sample reports; the RPT files 
may be opened and edited using a Crystal Reports application.  

The "Instance" folder contains copies of the sample reports in use by the 
TermLinx Server, which may not be edited. The TCM File>Instance menu allows 
newly-edited RPT files to be installed to Instance.  
 

3.4 Starting TermLinx Configuration Manager 

To start TermLinx Configuration Manager: 
1 Go to Start > Programs > ProSoft Technology > TermLinx > TermLinx 

Configuration Manager. 
2 Click OK to dismiss the Splash Screen. 
3 Enter the password when prompted. The default password is "termlinx". 
 

3.5 Starting a New Project 

To start a new project: 
1 Start TermLinx Configuration Manager.  
2 Choose Project > Configure Site.  

 

3 Configure your TermLinx Server (according to the information in the Site 
Configuration Dialog Box section).  

4 Choose File > Save As to save the project so you can open it again later.  
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Boot Mode Setting 

After configuring a site, you need to verify the Boot Mode setting, which must be 
"2" until you are ready to run TermLinx.  

To check the setting:  
1 Check the setting by going to File > Instance, (page 33) and then edit 

configuration entries and install files as appropriate.  

All installed files are copied to C:\TermLinx\Instance, except for any 3rd party 
Batch Controller executables which are copied to C:\TermLinx Programs. 
Refer to C:\Termlinx\Registry.txt for details.  

2 In the Configuration tab, select 0 (Automatic Startup) or 1 (Suppress Auto 
Start, one time).  

Important: Do not change the Boot Mode setting to 2 until you are ready to run TermLinx.  
 

3.6 Loading a Project 

You can open and edit a project you have previously saved. Do this if you have 
started, but not completed, the configuration of your project, or if you must modify 
the settings for a project that has already been downloaded to the module. 

To load an existing project: 
1 Start TermLinx Configuration Manager, and then choose File > Load. This 

action opens a dialog box that shows a list of TermLinx Configuration 
Manager project files (OPK files) in the current folder. 

Note: TermLinx Configuration Manager uses the folder you most recently used to load or save a 
TermLinx Configuration Manager project file. The first time you use TermLinx Configuration 
Manager, it will use the "C:\TermLinx\Projects" folder. 

2 Choose the project to load, and then click Open.  

To load a sample project: 
1 Go to File > Load.  
2 Navigate to the default projects folder, C:\TermLinx\Projects. This folder 

contains several default ProSoft sample projects.  
3 Choose the appropriate file:  

o ProSoftC.opk - for use with a ControlLogix PLC 
o ProSoftP.opk - for use with a PLC5 
o ProSoftS.opk - for use with an SLC 
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3.7 Site Configuration 

The Site Configuration dialog box opens when you go to Project menu > 
Configure Site.  

The first time you open the Site Configuration dialog box, the Site PLC 
Addresses dialog box opens on top of the Site Configuration dialog box. This will 
continue until the site's PLC files are configured.  

 

Operator/Site Name 
 Enter the name of the Terminal Operator in the Operator text box.  
 Enter the name of the TermLinx site in the Site Name text box.  

Note: The names you enter in the Operator/Site Name text boxes will appear near the top of the 
TermLinx Bay Status screen, if being used. Make sure to look at the Bay Status screen to verify 
that your entries fit on the screen.  

Site PLC Addresses  
It is very important that the site be configured in coordination with your corporate 
assignment of Product codes in the database, especially when multiple sites are 
to be administered from a central location. The Configurator must take this into 
consideration when preparing the PLC data files. PLC files must be assigned to 
the site and each island. Part of the island configuration is setting the 
accumulator characteristics, which relate to the type of batch controller being 
used. Certain settings are required when using an AccuLoad.  
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The site configuration requires two data files in the PLC: an integer file and a 
floating point file. Click the PLC Files button to display the Site PLC Addresses 
dialog box.  

 

Enter the PLC's memory addresses for each of these files.  
 Core: Both files are required, regardless of the number of loading or 

offloading islands configured.  
 Auxiliary: Reserved for future use.  

Note: Although these files may be placed anywhere in the PLC file block, it is recommended that 
they be in a continuous sequence.  

Select the Number of:  
 Islands at This Site 

Set this number to the total number of loading and/or unloading islands to be 
configured for your site. TermLinx supports up to 64 islands.  

Note: During site configuration, islands are defined for either lifting or dumping. Physical islands at 
a site are called "bays" in the TermLinx screen.  

 Gates at This Site 
Set this number to the number of gates at the terminal for your site. This 
feature currently applies only to OPACTS users, but is planned for an 
upcoming TermLinx release.  

 Blends for Your Site 
TermLinx allows a maximum of 32 different products or blends per site. If you 
plan to provide only two blends at your site, you should set the Blends box to 
2. However, if you configure the site for more blends than you are currently 
providing, you will not need to reconfigure the site PLC files if you add more 
blends later. The PLC Memory required for each blend is very small (4 
integer elements plus 2 floating point elements), so unless your PLC memory 
is very limited, we recommend configuring all 32 blends. 
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Set Transaction Pool Value 
This is the size of the Transaction Cache in RAM, which is the number of 
transactions that can be active at a terminal concurrently. Each Transaction 
requires about 500 bytes. Set this field to 4096 (default value).  

 

3.7.1 Site Configuration Dialog Box: General Tab 

Click the General tab to configure options for system-wide settings. 
 Processor Type: Choose PLC-5, SLC-500 or CL5550.  
 Measurement System: Select SI to show standard metric system units; 

select US to show USA units of measurement.  
 Transaction Retention Period (days): The value of this entry defines the 

period in days that the Transaction Data and expired Quotas will be kept in 
the TermLinx archives before being purged (deleted). 

 Standby Timeout (minutes): The time for which a standby transaction will 
remain active while an island is free and available for loading or unloading. 
The transaction will be deleted from the current transaction table after this 
time has elapsed. 

 Standby Limit (hours): Time in hours after which a standby transaction will 
be deleted unconditionally. 

 Maximum Standby Transactions per Driver: The maximum number of 
standby transactions a driver is allowed to have concurrently. For example, 
for a driver with a main truck and a pup (trailer), you can allow a driver to 
create one transaction for the main truck and a second transaction for the 
pup before proceeding to load either compartment.  

 End-of-Day Hour: This time is used by TermLinx for purging (deleting) 
posted transactions and quotas. 

 Require PIN at Island: Check if you want the Driver to enter the Driver ID 
and PIN when starting a transaction through an interface at the island. (Do 
not check if only the driver's ID must be entered.)  

 Transaction Log: Check if you want to log to printer every posted 
transaction. (A separate printer is recommended for transaction log printing) 

 Record Density as ...: Check if densities are to be logged in units of g/cc (SI 
units) or API gravity (US units). If this is not checked, densities are logged in 
units of kg/m3 (SI units) or relative density at 60°F (US units).  

 Mark Transactions as Uploaded: Check to automatically purge (delete) all 
posted transactions after the Transaction Retention Period is exhausted. If 
not checked, transactions are purged only when they are both (a) older than 
the Transaction Retention Period and (b) marked "uploaded", which is 
expected to be performed by an external corporate system after fetching 
them from the local database. 

 Allow Shutdown via PLC: Check to allow the controlled shutdown of 
TermLinx via commands set in the PLC (future implementation). 

 Orient Island Display R to L: Changes the position of the island numbers; 
numbers can appear in sequence from left to right, or from right to left.  

 Entero compatibility: Check if the site is managed by a corporate system 
running EnteroVision.   

 Caption for "Vehicle": Enter the word to be shown to the Driver which 
represents a vehicle capable of carrying product.  
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 Caption for "Quota": Enter the word to be shown to the Driver which 
represents the account, contact, or booking against which a transaction is to 
be charged.  

 Activate transaction at: Select where the driver can start a transaction: at 
the TermLinx touch terminal, at the Batch Controller (for example, AccuLoad), 
or at both the locations. 

 Caption for Minor Jurisdiction: Select to display State or Province for 
government jurisdictions of corresponding size.  

 

3.7.2 Site Configuration Dialog Box: Lift Tab 

Click the Lift tab to configure options for transferring product from the site to 
vehicles: 

 

 Minimum Authorizable Volume: Enter the minimum load size that can be 
lifted at each transaction. This volume must be at least as large as the largest 
minimum preset configured to any batch controller used for loading at the 
site. 

 Minimum Splittable Residue: Enter the volume below which the load cannot 
be split into a second transaction. This volume must be at least as large as 
the largest minimum preset configured to any batch controller used for 
loading at the site. 

 Maximum Authorizable Volume: Enter the maximum load size that can be 
lifted at each transaction. Enter "0" if no limit is required. This volume must 
not exceed the smallest maximum preset configured to any batch controller 
used for loading at the site. 

 Number of Copies of Ticket: Enter the number of copies of the ticket (bill of 
lading/unlading) to print upon completion of each transaction. 
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 Units of Preset Entry: Use the drop-down list to select the units for the 
volume entered by the driver for lifting product.  

 Assign ticket number sequence for...: Select Documentation completeness 
to assign by printed ticket, select Accountability completeness to assign by all 
transactions, or select Totalizer completeness to assign by any change in the 
accumulator.  

 Caption to use for "Lift": Enter the word(s) that you want to appear in the 
Mode box in the Driver's screen.  

 Preselect for Latest Transaction: Check this box to display the driver's last 
posted transaction selection values upon New Transaction creation. 

 Multiple Vehicle Trains: Check this box for TermLinx to be configured for 
transactions with multiple vehicle trains. This option is effective only when 
vehicle validation is enabled (by checking the Enable Vehicle Select box).  

 Multiple Batch Documents: This option allows for multiple batches to be 
printed on a single BOL document. For example, for a five-compartment 
vehicle, all five batches are printed on a single BOL document. 

 Enable Vehicle Select: Check this box to allow the driver to select a vehicle 
from a drop-down list as shown in the following picture:  

 

 Enable Customer Select: Check this box if the driver should select a 
customer from a drop-down list (similar to Enable Vehicle Select). 

 Require Manual Quota Acceptance: Check this box to require the driver to 
explicitly acknowledge a quota selection (even when there is only one 
available entry which would otherwise be selected and acknowledged 
automatically) to create a transaction.  



TLX-TCM ♦ TermLinx Configuration Manager Configuring TermLinx 
Terminal Management System  

 

Page 18 of 65  ProSoft Technology, Inc. 
October 23, 2008 

 

 Select Quota by Contract Number: Check this box to display the Quota 
Contract Number rather than the default Quota Confirmation Code.  

 Select Quota by Keypad Only: Check this box if the driver should enter the 
Quota Number using the keypad and not from a drop-down list. 

 Numeric Only Quota Entry: Check this box if the driver should enter the 
Quota Number using the NUMERIC keypad only. 

 Enable Consignee Select: Check this box to require a driver to select a 
consignee from a drop-down list. 

 Enable Destination Select: Check this box to require a driver to select a 
destination from a drop-down list. 

 Require Transaction Detail at Transaction Create: Check this box if you 
want drivers to see the Transaction Details screen as they begin their 
transaction.  

 Require Transaction Detail at Transaction End: Check this box if you want 
drivers to see the Transaction Details screen as they finish their transaction.  

 Auto-Print Documents: Check this box to print the ticket (BOL/BOU) 
automatically when the transaction is complete. 

 Warn "Compartment open to air": Check this box to ask the driver (during 
the vehicle selection step) if the vehicle has been opened to air. If the driver 
answers No, he may continue the transaction; if the driver answers Yes, he 
remains at the vehicle selection step and must select a different vehicle or 
answer no to the question in order to continue.  

 Warn "Change from last product": Check this box to ask the driver (during 
the product selection step) if the previous load was the same product. If the 
driver answers Yes, he may continue the transaction; if the driver answers 
No, he remains at the product selection step. The driver will be allowed to 
create a new transaction for a different quota (not recommended) or he can 
reattempt the transaction for the same quota and answer the question with a 
Yes.  
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3.7.3 Site Configuration Dialog Box: Dump Tab 

Click the Dump tab to configure options for transferring product from vehicles to 
the site: 

 

Most of the selections on this tab are the same as the Lift tab. The following are 
different:  
 Enable Supplier Select: Select (check) if the driver should select a supplier 

from a drop-down list. 
 Enable Producer Select: Select (check) if the driver should select a 

producer from a drop-down list. 
 Enable Source Select: Select (check) if the driver should select a source 

from a drop-down list. 
 High-water Shutdown Retry Limit: Enter the number of shutdowns a driver 

is limited to before a quota is locked out. This helps prevent drivers from off 
loading a whole truckload with a high water content.  

 High-water Shutdown Lockout Duration: Enter the number of hours that a 
quota remains locked out after exceeding the High-water Shutdown Retry 
Limit.  A quota is locked out if, at the time of transaction creation, the number 
of High-water Shutdowns for that quota occurring during the preceding 
Lockout Duration is greater than the Retry Limit. 
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3.7.4 Gate Configuration Dialog Box 

This dialog box opens when you click the Gates button on the Site Configuration 
dialog box. The first time you click the Gates button, the Gate n PLC Addresses 
dialog box opens on top of the Gate Configuration dialog box. This will continue 
until the gate's PLC files are configured.  

Note: You must select at least one gate in the Site Configuration dialog box for the Gate 
Configuration dialog box to appear. This feature currently applies only to OPACTS users, but is 
planned for an upcoming TermLinx release.  

Selected Gate 
Use the left and right arrows to select the Gate to configure. The number of gates 
is configured in the Site Configuration dialog box. 

Access 
Each gate may control Entry to the site, Exit from the site, or both.  
 An Entry gate has a keypad or card reader near the outside of the gate.  
 An Exit gate has a keypad or card reader near the inside of the gate. 

Note: A gate that opens automatically to allow exit is not an Exit gate. 

Each TermLinx Entry or Exit gate requires the driver to log in or out, using a 
keypad or card reader. 

Gate PLC Data File Addresses  
This button opens the selected gate's PLC File Addresses dialog box, allowing 
you to configure memory addresses within the PLC to use for Gate control. 
TermLinx requires two or three integer files and one floating point file for gate 
control in the PLC Data File Block.  

Set the data file address to 0 for each file that is not required. Set the other data 
file addresses according to the following:  
 Common address is required for all types of gates. 
 Entry address is required for all Entry gates. 
 Exit address is required for all Exit gates. 
 Auxiliary fields are reserved for future use.  

Note: Although these files may be placed anywhere in the PLC file block, it is recommended that 
they are in a continuous sequence.  
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Gate Configuration Options  
TermLinx uses the information from the Options section to control whether a 
driver can enter or exit a gate after logging in. 
 Blind control: For some types of gate configurations, the hardware and 

electronics at a gate may not be able to inform the PLC of the status of the 
gate (for example, open, closed, or in transit). For gates whose status cannot 
be monitored by the TermLinx, check the Blind Control box. 

 PIN required for entry: Check this box if the driver must enter a PIN 
(Personal Identification Number) on the keypad at the entry gate before the 
gate will open. This option is available only for Entry gates. 

 Lockout enable: Check this box if a driver whose record in the database is 
marked "Locked out", should not be allowed to enter. This option is available 
only for an Entry gate. 

Note: A locked-out driver is always allowed to leave. 

 TDG certificate required for entry: Check this box if a driver must have a 
valid CDL (Commercial Driver's License for US drivers, or Transport of 
Dangerous Goods for Canadian drivers) for entry. If the driver's CDL or TDG 
has expired and this option is selected, the driver may not enter. 

Note: A driver whose TDG has expired is always allowed to leave. 

 Driver's license required for entry: Check this box if a driver must have a 
valid Driver's License for entry. If the driver's license has expired, the driver 
may not enter. 

Note: A driver whose driver's license has expired is always allowed to leave. 

 Site orientation required for entry: Check this box if a driver must have a 
valid Site Orientation for entry. If the Site Orientation has expired, the driver 
may not enter. 

Note: A driver whose site orientation has expired is always allowed to leave. 

 PIN required for exit: Check this box if the driver must enter a PIN (Personal 
Identification Number) on the keypad at the exit gate before the gate will 
open. This option is available only for Exit gates. 

 LED response duration: Choose a value (in seconds) for this option for the 
LEDs on the gate keypad or other input device should illuminate. Typically, a 
green LED indicates that the driver is allowed to pass through the gate, while 
a red LED indicates that the driver is not allowed to pass through the gate. 
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3.7.5 Island Configuration Dialog Box 

The first time you click the Island button, the Island n PLC Addresses dialog box 
opens on top of the Island Configuration dialog box. This will continue until the 
island's PLC files are configured.  

This sub-dialog box can be opened by clicking the "PLC Files" button in the 
Island Configuration dialog box.  

Note: Physical islands at a site are called "bays" in the TermLinx screen.  

Island PLC Addresses  
TermLinx requires at least two integers and one floating point file for island 
control in the PLC Data File Block. Up to eight optional files are required if a 
transaction image of each posted transaction is to be written to the PLC for 
access by other systems (for example, SCADA) on the PLC's data highway.  

Set the data file address to 0 for each file that is not required. Set the other data 
file addresses according to the following:  
 Core: This address is required for the PLC to communicate with TermLinx.  
 Batch Controller I/F: This address is required for mutual communication 

among TermLinx, the PLC, and the Batch Controller.  
 Transaction Image - Main: Enter address in these fields if you want details 

of the most recent, completed transaction to appear in the PLC.  
 Transaction Image - Stakeholders: For the detailed description of the data 

fields available for the transaction image, refer to PLC Interface File Structure 
& Program Tags in the TermLinx Database Manager Manual.  

 Auxiliary fields: Reserved for future use.  

Note: Although these files may be placed anywhere in the PLC file block, it is recommended that 
they be in a continuous sequence.  
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Selected Island  
Use the Island arrows (in the top, right corner) to select the island to configure. 
The number of islands is configured in the Site Configuration dialog box. 

 

Tag  
Use this text field to give each island a distinctive name, up to 16 characters 
long.  

Mode  
Choose Lift (load) or Dump (unload) to define the type of transaction to use for 
this island. 

"Lift" ("Load") 

A lift island can: 
 Transfer product from the site to vehicles arriving at the site 
 Create Bill of Lading documents, which are legally required in order to 

transport a product  

"Dump" ("Unload" or "Offload") 

A dump island can:  
 Transfer product to the site from vehicles arriving at the site 
 Create Bill of Unlading or Product Receipt documents, which are useful for 

record-keeping purposes, and which may be legally required to transport or 
transfer a product. 

Base  
Choose Vol (volume) or Mass to define how the batch controller for the island 
measures the quantity of the commodity loaded or unloaded. 

Valid Blends  
Select (check) one or more blend types (up to 32) to allow for this island.  
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Flow Rate Units  
Choose Volume or Mass to define how to record the measured quantity of the 
commodity loaded or unloaded at this island, and then select the quantity (for 
example Liters, Gallons, Kilograms or Pounds), and the time interval (for 
example, Minute, Hour or Day) from the drop-down lists. 

Accumulator Characteristics  
TermLinx offers several choices for configuring product accumulator 
characteristics. These choices allow TermLinx to work with virtually any type of 
Batch Controller. 

 

Configure the properties of each accumulator type:  
 RW - Raw Meter Count 
 Vl - Volume 
 Ms - Mass 
 Vp - Vapor 
 UA, UB, UC - User Groups A, B, and C 

The configurable options in this part of the screen depend on the Accumulator 
Characteristics tab you select. The available options are: 
 Split Render Rollover 
 Batch Start (Zero or Tare) 
 Rollover value 
 Units (of measurement)  

Note: Options which do not apply to an accumulator type are not displayed when a tab is selected.  

The following table describes accumulator characteristics in more detail. 
Accumulator Type Qty Description 
Raw Meter Count 1 Raw Pulse Counter 
 
Volume (Converted to 
Liters/Gallons) 

5 Net Volume Accumulator 

  Gross Volume Accumulator 
  Gross Standard Volume Accumulator 
  Indicated Volume Accumulator 
  Water 
 
Mass (Converted to 
Grams/Pounds) 

1 Mass 

Vapor 2 Injection Accumulator 
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Accumulator Type Qty Description 
  Recovery Accumulator 
 
User Group A 5 Accumulator 1 
  Accumulator 2 
  Accumulator 3 
  Accumulator 4 
  Accumulator 5 
 
User Group B 5 Accumulator 1 
  Accumulator 2 
  Accumulator 3 
  Accumulator 4 
  Accumulator 5 
 
User Group C 1 Accumulator 1 

Accumulator Characteristics 

For an AccuLoad Batch controller, configure the following Accumulator 
characteristics: 
 Raw Meter Count 
 Volume 

These accumulators must be configured for a rollover of 1,000,000,000. For the 
Raw accumulator type, the check box for "Split Representation" must be cleared 
(unchecked). 
 Accumulator representation: Split or 32 bit 
 Rollover value  
 Units of measurement 

Batch Controller Type  
The following batch controller options are available: 
 AccuLoad AUT 
 AccuLoad STD 
 AccuLoad III-S 
 AccuLoad III-X 
 PLC with integrated flow computer 
 Toledo Weigh Scale 
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AccuLoad Configuration  

Configure your AccuLoad in the Batch Controller section of the Island 
Configuration dialog box. First, select your controller from the Batch Controller 
drop-down list, and then adjust the settings as needed.  
 Comm Port Number: Select a number for the Touch Terminal Port for serial 

data communications.  
 Device Address: Select a number for the address of the AccuLoad unit.  
 Secure Protocol: Check this box to select secure transmission of data 

(recommended); leave this box unchecked if you want data to be transmitted 
unsecured.  

Note: If you check the Secure Protocol box, settings for AccuLoad must be matched by 
corresponding settings in the TermLinx configuration file.  

 12-hour Clock: Check this box to assign the 12 hour format to the TermLinx 
clock; leaving the box unchecked sets the clock to the 24 hour format.  

Note: Clock settings for AccuLoad must be matched by corresponding settings in the TermLinx 
configuration file.  

 Volume Deemed as Net: Choose "Gross" if the AccuLoad performs no 
volume correction; choose "Gross Std" if the AccuLoad performs temperature 
correction only; or choose "Net" if the AccuLoad performs correction for both 
temperature and pressure.   

 Detect Product Leak: Check this box if you want the AccuLoad Batch 
Controller driver to monitor the sequencing of non-resettable totalizers 
against the batch volumes ticketed, in order to report unauthorized flow 
(product "leaks"). It is recommended to always turn on this option for newer 
installs.  

 Allow W&M Download: Check this box to allow TermLinx to download 
values of certain sealable parameters to the AccuLoad. For example, 
Standard Density and API Table Select.  

 Densitometer (does not apply to AUT model): Check this box if the 
AccuLoad receives density at operating conditions as a process input and 
uses the appropriate API tables to calculate Standard Density for use in 
further calculations.  

 AccuLoad Product (III-X model only): The AccuLoad III-X can implement 
up to 6 load points, each of which is assigned to a different TermLinx island. 
Enter the number as known by the AccuLoad for the product loaded at this 
island (through this AccuLoad load point).  

 Loggable Additives: The number of additives whose quantities TermLinx 
should inquire from the AccuLoad at the end of the transaction, along with the 
net volume (batch total). This number is limited by both the AccuLoad model 
and by TermLinx (can log up to 5 additives).  

Note: The number in this field must not exceed the number of additives actually injected by the 
AccuLoad.  
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 Additive Translation (III-X model only): The AccuLoad III-X identifies 
additives by the injector used to insert the additive substance into the loaded 
product stream, and therefore identifies the same additive substance by 
different numbers at different islands. TermLinx, however, identifies additives 
by the substance itself. This table translates TermLinx additive number (up to 
15 of them) to AccuLoad injector number for the additive at this island (where 
"0" means "not used").   

Note: TermLinx can record, in the transaction, the quantities of only the first 5 additives.  

PLC Configuration  

Configure your PLC in the Batch Controller section of the Island Configuration 
dialog box. Select PLC from the Batch Controller drop-down list.  
 Valve Sense: This setting is effective only when this island is the "dump" half 

of a dual-mode physical island for which the "lift" half has an AccuLoad as its 
batch controller. If the offload valve status of "open" and "closed" are reported 
in the PLC at points "Inn_P_VLVO" and "Inn_P_VLVC" (refer to "PLC Tags"), 
then set this option to provide a more informative and reliable interface to the 
driver for managing dumping transactions through the AccuLoad at that 
physical island. 

Toledo Configuration  

The Toledo is a weigh scale that is used for measuring by weight rather than by 
volume. Configure your Toledo in the Batch Controller section of the Island 
Configuration dialog box. First, select Toledo 8142 Dual Adv from the Batch 
Controller drop-down list, and then adjust the settings as needed.  
 Comm Port Number: Select a number for the Touch Terminal Port for serial 

data communications.  
 Device Address: Select a number for the address of the Toledo unit.  
 Secure Protocol: Check this box to select secure transmission of data 

(recommended); leave this box unchecked if you want data to be transmitted 
unsecured.  

Note: If you check the Secure Protocol box, settings for Toledo must be matched by corresponding 
settings in the TermLinx configuration file.  
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3.7.6 Physical Island Mapping Dialog Box 

This dialog box opens when you click the Mapping button on the Site 
Configuration dialog box. Use this dialog box to associate pairs of logical 
("TermLinx") islands—one Lift and one Dump—to single physical islands. 

Note: Physical islands at a site are called "bays" in the TermLinx screen.  

The Physical Island Mapping dialog box also allows you to assign TermLinx 
Islands to specific Physical Islands even if no Lift-Dump pairs are created. For 
example, when you want to re-number the islands.  

 

The term "TermLinx Island" is used to represent what manages the monitoring, 
control, and recording of product flow through a transfer point according to 
authorizations and constraints available in TermLinx's Accounting Database. 

Normally, TermLinx Islands operate independently of each other. A Lift Island 
can be in the process of delivering product into a truck while an adjacent Dump 
Island is busy receiving product from another truck. 

At some sites, physical transfer points may be capable of product transfer in 
either direction, that is, a "physical island" may be capable of both "lifting" and 
"dumping", even though such an island cannot transfer in both directions at the 
same time. 

For each such Lift/Dump Island pair: 
 The two TermLinx Islands are constrained so that when one of them is active 

the other is "temporarily disabled" and cannot start a transaction. 
 If a third-party Batch Controller (such as an AccuLoad) is used for the Lift 

side of the pair, while also providing a conversation path for the driver's 
convenience in controlling the load, this conversation path is enhanced to 
include selection of direction of flow ("Mode"). 

 The PLC must implement additional logic to coordinate the interlock of the 
two TermLinx Islands. 
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Move Up / Move Down buttons 
Use these buttons to reorder the selected island. 

Split button 
Use this button to break a link between a Lift Island and a Dump Island. 

Join button 
Use this button to create a link between the selected island and the island 
immediately below it in the list that must be of the opposite mode. 
 

3.7.7 Setting Date and Time in TermLinx 

The date and time are displayed in the upper, right corner of TermLinx. TermLinx 
uses the entries in the Windows Time and Short Date fields to display the date 
and time in TermLinx.  

To change the settings for the clock and date: 
1 Go to Start > Control Panel > Regional and Language Options and select the 

Regional Options tab, and click the Customize button.  
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2 Enter the date and time exactly as it should appear in TermLinx. For 
example, if you want it to show AM, PM, or 24 hour time.  

 

3 Click OK to apply your changes and close the Regional and Language 
Options dialog box.  

 

3.8 Saving Your Configuration 

When you have finished configuring your site, gates, and islands, you must save 
your project, and then transfer the configuration files to the TermLinx server and 
the AccuLoad interface. 

To save your configuration: 
1 Click the Done button on all open dialog boxes.  
2 Open the File menu and choose Save. 
3 In the File Save dialog box, enter the project name, and then click Save. 

Configuration information is saved in two forms: a binary form (.OPK), and a 
script form (.OPS). These two files contain the same information, but are used for 
two different purposes. The binary file is used for fast loading by the TermLinx 
Server. The script file is used for porting configuration between different versions 
of TermLinx, and for providing configuration information to batch controllers. 
When loading a TermLinx project, you may choose to load either form. When 
saving a TermLinx project, both files are written automatically.  

The default location for the project files is C:\TermLinx\Projects directory. 

The default names for the project files are: 
 TermLinx.OPK 
 TermLinx.OPS 
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3.9 Creating the PLC Database Tag File 

The PLC Database Tag File configures memory areas in the PLC to use for 
TermLinx configuration, gate, and island control. 

To generate the database tag file for loading into the PLC processor:  
1 Open the Project menu and choose Make PLC Database File. This action 

generates a database file in CSV (Comma Separated Values) format. The 
filename matches the name of the project configuration files, and has the 
extension CSV.  

2 Import this file into the PLC program. 
 

3.10 View Configuration Script Dialog Box 

This dialog box opens when you choose View Configuration Script from the 
Project menu. Use this dialog box to view the contents of the configuration script 
(.OPS file) generated when you save a TermLinx project file. 

 

The following example shows a typical Configuration Script. 
; Generated by Tlnx_Cfg (02-17-2006 @ 16:48:07) 
 
[SITE] 
 DATE=2006-02-17.16:38:54 67108864 
 PROCTYPE=0 
 OPERATOR= TermLinx 
 NAME= Truck Terminal 
 MSYS=1 
 BLENDS=32 
 DOCUMENTS=32 
 ISLANDS=8 SHARED ACTVAL PIN NOLOG NODSCALE NOUPLD NOSHDN ORNT_L NOENTERO 
 GATES=1 
 TRANSACTIONS=4096 
 KEEPDAYS=60 
 STBYTIMEOUT=120 99 
 STBYMAX=2 
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 EODH=0 
 WATERLIMIT=0 
 CPTNVHCL= Vehicle 
 CPTNQOTA= Quota 
 CPTNJDCT=0 
 CPTNLIFT= Load 
 CPTNDUMP= Unload 
 MINPRESET=50 1 
 MINSPLIT=10500 1 
 MAXPRESET=10500 0 
 TKCOPIES=1 1 
 PSUNITS=0 0 
 TKSQNC=0 0 
 PHYSISLD=8 1 0 2 0 3 0 4 0 5 0 6 0 7 0 8 0 
 LIFT= PRESLCT NOMVT NOMBD NODTS NODTL VHCL CSTR NOQSLCKEY NOQNBR NOCNSG DSTN 
AUTODOC 
 DUMP= PRESLCT NOMVT NOMBD DTS NODTL NOVHCL NOSPLR NOQSLCKEY NOQNBR NOPDCR 
NOSRCE AUTODOC 
 LIFTWARN= AIR PRDC 
 PLCFILE= NT 100 0 FL 101 0 VN 0 0 0 VF 0 0 0 
[ISLD01] 
CONTROLLER= ACCU_AUT 1 3 2 PTCLASCII CLK24 NOWMDOWNLOAD 
MODE= LIFT 
ACUMRW= 1000000000 0 32BIT NOZERO 
ACUMVL= 0 0 SPLIT ZERO 
ACUMMS= 0 3 SPLIT ZERO 
ACUMVP= 0 3 32BIT NOZERO 
ACUMUA= 0 0 32BIT NOZERO 
ACUMUB= 0 0 32BIT NOZERO 
ACUMUC= 0 0 32BIT NOZERO 
BLENDS= 1 2 
DOCUMENTS= 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 
27 28 29 30 31 32 
PLCFILE= 84 0 85 0 184 0 185 0 
[ISLD02] 
CONTROLLER= NONE 
MODE= DUMP 
ACUMRW= 32000 0 32BIT NOZERO 
ACUMVL= 10000000 0 32BIT NOZERO 
ACUMMS= 100000000 3 32BIT NOZERO 
ACUMVP= 100000000 3 32BIT NOZERO 
ACUMUA= 0 0 32BIT NOZERO 
ACUMUB= 0 0 32BIT NOZERO 
ACUMUC= 0 0 32BIT NOZERO 
BLENDS= 3 
DOCUMENTS= 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 
27 28 29 30 31 32 
PLCFILE= 82 0 83 0 0 0 0 0 
[GATE01] 
ACCESS= ENTR NOPNIN LKOT TCXD NODLXD SOXD BLIND 
LEDRSP=5 
PLCFILE= 90 0 
; End 
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3.11 Installing TermLinx Configuration Files 

The TermLinx system uses configuration files that allow you to design TermLinx 
for a specific site. The TermLinx Configuration Manager software creates and 
maintains the following configuration files: 
 TermLinx Binary Configuration file: <filename>.OPK 
 TermLinx Script Configuration file: <filename>.OPS 

You must copy these files to the correct locations for the TermLinx Server and 
the PLC to load them when the system starts up. 

Note: You must shut down TermLinx in order to install a new configuration file. 
 

3.12 TermLinx Instance Dialog Box 

Important: This dialog box is available only when you run TCM on the computer that hosts the 
TermLinx Server.  

TermLinx configuration information is stored in the Windows registry on the 
machine running the TermLinx Server. The TermLinx Instance dialog box 
simplifies the task of managing these configuration entries, and protects the 
registry from accidental changes. To view and modify these settings, run TCM on 
the TermLinx Server machine, and use the TermLinx Instance dialog box.  

In TCM, go to File > Instance to open the TermLinx Instance dialog box, which 
allows you to manage configuration entries and their associated files in the folder 
"C:\TermLinx\Instance".  

 

Use this dialog box to copy an instance of the configuration files to this specific 
TermLinx server. When you are done configuring an instance, click Apply to save 
your settings.  
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Important: Each time you make changes in DBM, you must click Apply to save the settings. The 
Done button will not save changes.  
 

3.12.1 Setting Logo Screen and Boot-Up Info 

Click the Configuration tab to configure how TermLinx starts up. 
 Active Project: type = REG_SZ, name = ActiveConfigFile 

The full path to the live Operational Database file for the running TermLinx 
instance. This file, which has an extension of .OPK, is created by the 
TermLinx Configuration Manager application, and normally resides in the 
instance's current directory ("DirInstance" below). This path should *not* be 
that of a project .OPK file.  

 Logo Screen: type = REG_DWORD, name = LogoScreen 
If non-zero, all TermLinx screens time out to the Startup screen, which 
typically displays the customer's company logo. If zero, then all screens time 
out to the Overview screen if present, otherwise to the Login screen, and the 
Startup screen is never displayed.  

 Logo Image File: type = REG_SZ, name = LogoImage  
The full path to the graphic image file containing the customer's logo, if any, 
which file normally resides in the instance's current directory ("DirInstance" 
above). If the file exists, the image is shown on the TermLinx Startup screen 
and may also be displayed on the TermLinx Login screen. Valid graphic 
image file formats are .BMP, .DIB, .GIF, .JPG (.JPEG), .WMF, .EMF, .ICO, 
and .CUR. The image is scaled and stretched to fit within a region of 480 
pixels horizontal by 320 pixels vertical (600x400 for the SVGA model) placed 
against a black background, hence to avoid excessive distortion the image 
should be as close to this size (larger scales down better than smaller scales 
up) and aspect ratio (3:2) as possible, and to merge smoothly with its 
surround the edges of the image should be black or transparent. Since the 
.JPG (.JPEG) format yields the best results under such scaling and 
stretching, this format is recommended. 

 Session Notice File: type = REG_SZ, name = SessionNotice 
The full path of a document file to be displayed each time a driver logs in, 
which normally resides in the instance's current directory ("DirInstance" 
above). If the file is not defined or cannot be found, then the driver is logged 
into the Main screen directly upon providing a valid ID and PIN. If the file is 
found, then its contents are displayed in a window after entry of valid ID and 
PIN and before the Main screen is displayed; the driver must acknowledge 
having read the document before proceeding to the Main screen. The file is 
displayed as a Rich Text Format file if its name has the extension ".rtf" and as 
a plain text file if its name has any other extension."  

 Boot Mode: type = REG_DWORD, name = XqNoAutoStart  
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A non-zero value prevents TermLinx from restarting automatically upon boot. 
When TermLinx starts, its first action is to read this value, and only if it is zero 
(or missing) does TermLinx continue to start; otherwise TermLinx terminates 
immediately. If the value is 1, however, TermLinx sets this value to 0 before 
quitting, making startup suppression a one-time-only action. This value is set 
to 1 by one of the TermLinx shutdown options. For extensive maintenance 
requiring many non-TermLinx boots, set this value to other than 0 or 1 (e.g. 
2); when maintenance is complete and TermLinx is to be restarted, set this 
value back to 0 before rebooting.  

Note: Installation of TermLinx installs this value as 2, so that the procedures of setting up a new 
site, which may require many boots, can proceed without interference by TermLinx. Set this value 
to 0 to enable TermLinx for the first time.  

 Emergency GUI Login Driver/P.I.N.: type = REG_DWORD, names = 
EmergencyDvnr and EmergencyPinr 
If during a login attempt the entered Driver Number and PIN match these two 
values, then the login is granted and given SuperTrucker authority without 
validating the entries against the DRVR table of the database. This 
"Emergency GUI Login" feature allows recovery from situations in which a 
database-defined SuperTrucker is missing or inaccessible (such as a 
database crash) that would otherwise make some maintenance procedures 
difficult or impossible (such as shutting down TermLinx). Since TermLinx 
requires both Driver Number and PIN to be non-zero before proceeding with 
a login, this emergency capability may be disabled by setting either (or both) 
of these two values to zero. These two values, in particular, may be changed 
at any time, and the change is effective at the next login attempt. This feature 
should NOT be regularly used to authorize product-transfer transactions; for 
those, use database-defined DRVR entries instead.  

Note: Installation of TermLinx installs both these values as "1"; be sure to disable Emergency 
Login (or change the "1"s to numbers that are hard to guess) after the database has been 
populated. 

Configuration Names and Values for Logo and Boot-Up  

The following are examples.  
 DirInstance: Shows the where TermLinx resides.  
 ActiveConfigFile: C:\TermLinx\Instance\TermLinx.opk 
 LogoScreen: LogoScreen=1 
 LogoImage: LogoImage="C:\TermLinx\Instance\TermLinx.jpg" 
 SessionNotice: SessionNotice="C:\TermLinx\Instance\Notice.rtf" 
 XqNoAutoStart: XqNoAutoStart=1 
 EmergencyDvnr: EmergencyDvnr=0 
 EmergencyPinr: EmergencyPinr=0 
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TermLinx Configuration Files 

The TermLinx Binary Configuration file (<filename>.OPK) contains all the 
configuration information required by the TermLinx service. When the TermLinx 
server starts up, it reads the binary configuration file to determine how many 
loading or unloading islands to service, PLC data mapping, and so on. 

TermLinx Configuration Manager saves the binary configuration file in 
C:\TermLinx\PROJECTS 

Before you start the TermLinx server, you must copy the configuration file to 
C:\TermLinx\INSTANCE 

Because the TermLinx server locks the file during operation, you must stop the 
server to update the configuration file. The TermLinx server will read the new 
configuration file the next time the server is started. 
 

3.12.2 Setting Database User IDs and Passwords 

Click the Database tab to configure how TermLinx stores database login 
information. 
 Active Site Code: type = REG_SZ, name = ActiveSite 

The site identifier for the running TermLinx instance, used for interrogating 
the Accounting Database. This identifier is the primary key to the SITE and 
STRF tables, and the first component of the primary key to each of the 
remaining tables (excluding VRSN).  

 ODBC Data Source: type = REG_SZ, name = OdbcDsnActg  
The ODBC data source name (DSN) of the Accounting Database for the 
running TermLinx instance. This name implies not only the location of the 
Database but also the ODBC driver needed to access it.  

 Database Login, Kernel User Id/Password: type = REG_SZ,  
o name = OdbcKrnUser  

The user ID used by the privileged TermLinx software for logging into the 
Accounting Database.  

o name = OdbcKrnPswd 
The password used by the privileged TermLinx software for logging into 
the Accounting Database. 

 Database Login, Application User Id/Password: type = REG_SZ,  
o name = OdbcAppUser  

The user id used by external applications such as the TermLinx Database 
Manager, the TermLinx Database Wizard, or a host system for logging 
into the Accounting Database.  

o name = OdbcAppPswd  
The password used by external applications such as the TermLinx 
Database Manager, the TermLinx Database Wizard, or a host system for 
logging into the Accounting Database. 
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 Maximum Connection Retries: type = REG_DWORD, name = 
OdbcConnectMaxRetry 
In some boot environments, it may take some time for the database service 
to become fully operational and ready to respond to connection requests. 
During boot, the TermLinx kernel repeatedly attempts to connect to the 
database at a frequency of about one attempt every two seconds until the 
connection succeeds or this count is exhausted.  If missing or erroneous, a 
value of 120 is assumed.  

Note: If the TermLinx GUI starts before the database service is ready it may become unresponsive 
(appear to freeze). The GUI will resume responding when the database connection has been 
established (or deemed to fail).  

 TermLinx Schema Owner: type = REG_SZ, name = OdbcSchema 
The name of the owner of the database schema that is compatible with the 
TermLinx system.  Two choices are available: "OPACTS" is for use with pre-
existing database schemas installed originally for TermLinx's predecessor 
OPACTS, and "TERMLINX" is for use with newer installations.  All new 
installations assume (and require) schema owner "TERMLINX". 

Configuration Names and Values for User IDs and Passwords 
The following values are just examples:  
 ActiveSite: ProSoft  
 OdbcDsnActg: TERMLINX  

OdbcKrnUser: TERMLINX_KRN 
 OdbcKrnPswd: termlinx_krn 
 OdbcAppUser: TERMLINX_MGR 
 OdbcAppPswd: termlinx_mgr 
 OdbcConnectMaxRetry: 120  
 OdbcSchema: TERMLINX 

 

3.12.3 Setting Formal Report Printing and File Paths 

Click the Printing tab to configure how TermLinx prints documents and log files.  
 Bill of Lading Port: type = REG_SZ, name = PrinterPortBol 

The device name of the parallel port connected to the printer of the Bill of 
Lading (Lift Ticket). This version of TermLinx supports only printers 
connected directly to physical parallel or USB ports (page 38); serial and 
network printers are not supported. 

 Bill of Lading Report Definition File: type = REG_SZ, name = 
DocDefinitionBol 
The full path to the document definition file for the Bill of Lading (Lift Ticket). 
This file, which typically has an extension of .RPT, is created by the 
commercial product Crystal Reports, and normally resides in the instance's 
current directory ("DirInstance" above).  This path should *not* be that of a 
Crystal Reports working file that may be subject to editing. 

 Product Receipt Port: type = REG_SZ, name = PrinterPortBou 
The device name of the parallel port connected to the printer of the Bill of 
Unlading (Dump Ticket).  
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 Product Receipt Report Definition File: type = REG_SZ, name = 
DocDefinitionBou 
The full path to the document definition file for the Bill of Unlading (Dump 
Ticket). This file, which typically has an extension of .RPT, is created by the 
commercial product Crystal Reports, and normally resides in the instance's 
current directory ("DirInstance" above).  This path should *not* be that of a 
Crystal Reports working file that may be subject to editing. 

 Transaction Log Port: type = REG_SZ, name = PrinterPortLog 
The device name of the parallel port connected to the printer of the 
Transaction Log. 

Configuration Names and Values for Document Printing 

The following values are just examples:  
 PrinterPortBol: LPT1: 
 DocDefinitinBol: C:\TermLinx\Instance\BOL.rpt 
 PrinterPortBou: LPT2: 
 DocDefinitionBou: C:\TermLinx\Instance\BOU.rpt  
 PrinterPortLog: LPT3: 

 

USB Printer Configuration Tip 

Although TermLinx is designed to output to a printer physically connected to the 
computer's LPT port, you can create a "virtual" LPT port that allows you to 
connect to a printer that uses a USB connection.  

For a general discussion of how to configure virtual ports on a computer, please 
refer to Microsoft knowledgebase article 154498 
http://support.microsoft.com/kb/314499/.  

Important: Your computer must be configured to allow File and Printer Sharing. If you have not 
already done so, please install and enable the File and Printer Sharing service in your Local Area 
Connection Properties.   

 

http://support.microsoft.com/kb/314499/
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To configure TermLinx to use a USB printer 
1 Install the driver for your USB printer. 
2 Open the Printer Properties dialog box, and then click the Sharing tab. 

  

3 Select "Share this printer", and make a note of the Share Name. 
4 Click OK to save your settings and dismiss the dialog box.  
5 Click Start / Settings / Control Panel, and then open System. Make a note of 

the full computer name, for example "termlinx.domain.com".  
6 Click Start, and then click Run. 
7 In the Open box, type cmd, and then click OK. 
8 Type  

net use lpt2 \\<Full Computer Name>\<USB Printer Name> /persistent:yes 

where <Full Computer Name> is the computer name noted in step 2, and 
<USB Printer Name> is the name of your USB printer, from step 1.  
Press [Enter] to execute the command.  

9 To quit the command prompt, type exit, and then press ENTER. 

Important: You must set this as the default Windows printer. 

Use the virtual printer port (LPT2 in this example) in your TermLinx configuration.  
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3.12.4 Setting PLC Connection Information 

Click the PLC connection tab to configure how TermLinx connects to the PLC.  
 Station Path: type = REG_SZ, name = RSLinxStationPath 

The path definition from the TermLinx computer to the processor. For an 
application where the computer is connected to the processor through a 
Rockwell Ethernet adapter(1756-ENET/1756-ENBT) in the same rack. this 
value should be entered as follows:  

16.12.<1756-ENBT/1756-ENET IP address in ASCII mode>.1.<ControlLogix Processor 
Slot Number> 

For example, if the 1756-ENET card IP address is 105.102.0.65 and the 
processor is located in the same rack in slot 0, the station path would be set 
as follows:  

16.12.49.48.53.46.49.48.50.46.48.46.54.53.1.0 

 Processor Type: type = REG_SZ, name = RSLinxProcType 
The processor type code for the other end of the RSLinx connection. Valid 
choices are: "PLC5" and "SLC500" (use "PLC5" for connection to a CL5550). 

 RSLinx Driver: type = REG_SZ, name = RSLinxDriver 
The RSLinx driver used for communicating with the PLC. 

 RSLinx Port Id: type = REG_SZ, name = RSLinxPortId 
The RSLinx port id provided to the driver when communicating with the PLC. 
Valid values are "AB:LOCAL", "AB:NAME", and "AB:CIP". 

 Processor Poll Timeouts Kernel / Application: type = REG_DWORD,  
o name = RSLinxTmotKrn  

The timeout in milliseconds used for critical ("kernel") RSLinx polls from 
TermLinx to the PLC.  This number should be large enough so that a 
timeout occurs only when the connection is genuinely lost.  

o name = RSLinxTmotApp  
The timeout in milliseconds used for non-critical ("application") RSLinx 
polls from TermLinx to the PLC. This number should be large enough so 
that most polls succeed but small enough so that a genuinely lost 
connection does not overly degrade system response. 

Configuration Names and Values for PLC Connection 

The following values are just examples:  
 RSLinxStationPath: 0.43.1.0  
 RSLinxProcType: PLC5 
 RSLinxDriver: AB_KT-1 
 RSLinxPortId: AB:LOCAL 
 RSLinxTmotKrn: 5000  
 RSLinxTmotApp: 1000 
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3.12.5 Setting Batch Controller Application Info 

Click the Batch controllers tab to configure how TermLinx communicates to a 
batch controller.  
 Batch Controller Application #1: type = REG_SZ, name = RunBCApp<nn> 

The full path to the executable (program file or command file) that is to run 
instance "<nn>" of an external Batch Controller driver.  "<nn>" is replaced by 
"01" to specify the executable of the first Batch Controller instance, is 
incremented by 1 to "02" to specify the second instance, and so on until the 
value for "<nn>" is not found.  "<nn>" has no significance to TermLinx except 
to distinguish multiple instances, to associate with each instance its 
arguments using "RunBCArg<nn>", and to specify the order of startup. 
TermLinx supplies two Batch Controller Applications: "BctlAccu.exe" for 
interfacing with AccuLoad batch controllers, and "BctlTled.exe" for interfacing 
with Toledo Weigh Scale batch controllers. Both programs, if installed, should 
reside in folder "C:\TermLinx\Programs". 

 Batch Controller #1 Arguments: type = REG_SZ, name = RunBCArg<nn> 
The arguments to the Batch Controller instance invoked by "RunBCApp<nn>" 
for corresponding "<nn>", when required. 
Each running instance of a TermLinx-supplied Batch Controller Application 
manages the interface to all corresponding devices accessible through a 
single serial port.  This access may be to a single batch controller device via 
an RS-232 connection, or it may be to many such devices residing on a RS-
485 multidrop loop. The three arguments to either "BctlAccu.exe" or 
"BctlTled.exe" specify the local port number and characteristics of that serial 
connection; arguments are, in order: (1) the number of the COM port to be 
used, (2) the baud rate of the connection, and (3) two characters specifying 
the parity and number of data bits for the connection. For example, "1 9600 
e7" specifies "use COM1 at 9600 baud with Even parity and 7 data bits". Do 
NOT use the same COM port number for more than one Batch Controller 
driver instance. 

 Batch Controller Application #2: type = REG_SZ, name = RunBCApp<nn> 
See Batch Controller Application #1 above.  

 Batch Controller #2 Arguments: type = REG_SZ, name = RunBCArg<nn> 
See Batch Controller Arguments #1 above.  

Configuration Names and Values Batch Controllers  

The following values are just examples:  
 RunBCApp01: C:\TermLinx\Programs\BctlAccu.exe  
 RunBCArg01: 1 9600 e7 
 RunBCApp02: C:\TermLinx\Programs\BctlTled.exe 
 RunBCArg02: 2 9600 e7 
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4 Configuring the TermLinx AccuLoad Interface 

In This Chapter 

 Program Settings...................................................................................43 

 PLC Interface ........................................................................................45 

 AccuLoad Driver Interface .....................................................................45 

4.1 Program Settings 

TermLinx supports four AccuLoad models as TermLinx batch controllers: the 
AUT, the STD, the III-S, and the III-X.  

Some settings for AccuLoad must be matched by corresponding settings in the 
TermLinx configuration file, which you create and maintain with TermLinx 
Configuration Manager. Some AccuLoad settings must also be matched by 
arguments given to the invocation of the Batch Controller Driver program.  

Settings that must match between TermLinx and AccuLoad are indicated with a 
highlight in the following tables. 
 

4.1.1 AccuLoad AUT ("AccuLoad I") 
 

Point Description Cfg Value Notes 
02 Pulse Output to Printer  0/1 No local printer 

03 Maximum Preset Quantity   Maximum vehicle capacity or greater, or 
00000 

19 Communication Type * 1/3 Secure protocol? 

20 Communication Control  3 Remote control 

21 Communication Address * <value> On same communications loop all 
distinct 

26 Military/Standard Time * 0/1 12-hour clock? 

32 Flashing Totals Display  0 Interferes with prompt download 

37 Auto Preset Mode  1 Prevent change at AccuLoad 

52 Display Units * 1/2/4 Metric 

53 Preset Delivery Display * 00/11/22 Compensation 

64 Temperature Units * 0/2 Metric 

65 Reference Temperature  0150 If required 

67 Protect Codes 90 to 96  0/1 Must download density 

68 Programming thru Comm  2/1 Depending on #67 
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Point Description Cfg Value Notes 
69 Pressure Units * 0/2/3 Metric 
73 Stand-Alone Timeout  1xxx/x000 No standby mode 

91 API Table & Product 
Select 

 <value> Correspond to TermLinx product/blend 

92 Reference Density  ----- Downloaded 

93 Compressibility Factor  00000 Use reference density 

96 Print Button Operation  0 Allow End Tran at island 
 
 

4.1.2 AccuLoad STD ("AccuLoad II") 
 

Point Description Cfg Value Notes 
107 Flashing Totals Display  0 Interferes with prompt 

301 Transaction Control  1 Allow End Tran at island 

302 Maximum Preset Quantity  <value> Maximum vehicle capacity or greater, or 
00000 

303 Minimum Preset Quantity * <value> Minimum authorizable volume or less, or 
00000 

304 Auto Preset Mode  1 Prevent change at AccuLoad 

345 Volume Type, Preset * <value> Compensation 

346 Volume Type, Delivery * <value> Compensation 

441 Temperature Units * 0/2 Metric 

442 Reference Temperature  0150 If required 

444 API Table & Product Select  <value> Correspond to TermLinx product/blend 

445 Reference Density  ----- Downloaded if no dmtr 

541 Pressure Units  0/2/3 Metric 

544 Pressure Coefficient  00000 Use density 

701/5 Communication Type * 1/2 Secure protocol? 

702/6 Communication Control * 2 Remote control 

703/7 Baud Rate * <value> On same communications loop all same; 
match jumper on any/all AUT on loop 

704/8 Data Format * <value> On same communications loop all same; 
must be 0 (E7) on loop containing AUT 

709 Communication Address * <value> On same communications loop all distinct 

741 Programming thru Comm  2 Must download density 

742 Communications Timeout  <value> Longer than longest scan time of driver, or 
000 

743 Communications Alarm 
Mode 

1 <value>  
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4.2 PLC Interface 

AccuLoad uses the following groups of PLC data points: 
 Producer 

Signals 
Current accumulators 
Alarms and status 
Live accumulators 

 Consumer 
Batch controller program 
Estimated/requested volume 

 

N:192& 2 Iii_DRVR P B X Driver number 
N:194& 2 Iii_RPIN P B X PIN number 
N:196& 2 Iii_RTSQ P B X Selected Transaction sequence number 
N:198 1 Iii_RTSL W B X Selected Transaction candidate index 
 
 

4.3 AccuLoad Driver Interface 

The AccuLoad terminal consists of a display screen and a keypad. 

AccuLoad prompts a driver to enter a response from the keypad. This response 
consists of zero or more digits followed by the "E" key. At an AccuLoad-STD, the 
string of digits must also be preceded by the "E" key. 
 

4.3.1 AccuLoad Prompts 

Ready 

While an island is off-line, the AccuLoad displays a "Ready" prompt. From the 
"Ready" prompt, an authorized driver can: 
 Enter Program Mode.  
 Place the island off-line manually through the TMI.  
 Place the island off-line automatically if there is an alarm condition.  
 Clear an alarm condition to place the island back on-line. 

Enter Driver No. 

When an island is online, the AccuLoad continuously displays an "Enter Driver 
No." prompt. 

Enter PIN 

For security reasons, the AccuLoad may be configured to require a Personal 
Identification Number or password as well as a Driver Number. A driver normally 
has 15 seconds to enter a PIN, otherwise the AccuLoad returns to the "Enter 
Driver No." prompt. 
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After a driver enters the PIN, the AccuLoad looks up the driver's database record, 
and returns one of the following prompts: 
 "INVALID" 

Driver number not found, or incorrect PIN; reverts to the "Enter Driver No." 
prompt after 10 seconds or upon any entry. 

 "NO TRANSACTIONS" 
Driver valid, but no standby Transactions valid for this driver and this island; 
reverts to "Enter Driver No." prompt after 10 seconds or upon any entry. 

 "1E-Select E-Next" 
Alternates with the vehicle "equipment type" for one of the valid standby 
Transactions; reverts to "Enter Driver No." prompt after 30 seconds. An entry 
of "1" issues an initial "Start" for the selected Transaction; any other entry 
rotates the selection to the next valid Transaction and restarts the timeout. 

Start 

Upon selection, the Transaction undergoes an initial "Start" at the island. 

Can't Authorize 

If the Start fails, the prompt "CAN'T AUTHORIZE" is issued, remaining for 10 
seconds (or until any entry) before reverting to the idle prompt. 

Preset 

Upon Transaction authorization the AccuLoad displays its usual "preset" prompt. 
The Driver starts Product flow with the "Set" key; the preset amount cannot be 
altered. During flow, the Driver uses the "Start" and "Stop" keys as necessary. 
When done, the AccuLoad can terminate the Transaction itself, or, if necessary, 
the Driver may do so with the "Print" key. 

Upon Transaction termination, the AccuLoad normally reverts to the "Enter Driver 
No." prompt, unless the original preset amount exceeds the amount actually 
transferred by at least the configured "Minimum Splittable Residue" 

nnn Left-Split 

For transactions where the original preset amount exceeds the amount actually 
transferred, the AccuLoad issues the prompt "nnn Left-Split?" (where "nnn" is the 
residue) alternating with "1E-No, 2E-Yes". 
 YES 

The residue becomes the preset for a split Transaction 
 NO, or no entry for 30 seconds 

The residue is discarded 
 Any other entry repeats the prompt and restarts the timeout. 

After this selection the AccuLoad reverts to the idle prompt. 
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5 TermLinx PLC Ladder Logic Interface 

In This Chapter 

 The PLC As a Batch Controller .............................................................47 

 Run TermLinx from Any HMI .................................................................49 

 PLC Implications for an AccuLoad Batch Controller..............................50 

 Sample Ladder ......................................................................................50 

 Ladder Logic Diagram ...........................................................................51 

 
 

5.1 The PLC As a Batch Controller 

TermLinx requires ladder logic in the PLC processor to communicate with the 
TermLinx server. The TermLinx computer requires a communications interface 
via RSLinx to the processor. 

1 TermLinx requests an initial "start" of the transaction, by latching "PLC 
request enable transaction". The PLC must accept or reject the request, 
based on "authorization permissive" status (maintained by the PLC). 
o Accept: The PLC latches "xqv accept enable"; TermLinx will unlatch both 

this and "PLC request enable transaction". 
o Reject: The PLC unlatches "PLC request enable transaction". This 

handshake is required for all islands, including those whose primary batch 
controller is another device such as an AccuLoad. 

2 If the PLC accepts the "start" request, TermLinx passes control of the 
transaction to the batch controller. The PLC may use the handshake in (1) 
above to change its internal state to, for example, "transaction in progress", 
for modifying its behavior under such conditions as "ground strap not 
connected" (while "transaction in progress" this should be alarmed; otherwise 
it does not matter). 

3 The PLC should maintain status bits in Nxx:3, in particular: 
o "flowing": product is moving (for example, "pump is on"). 
o "busy in sequence": any sequence or state or transition that should 

prevent a transaction from being "end"ed (for example, pump on, valve 
open, and so on.). 

4 While a transaction is in progress, the user may "stop" and/or "start" it as 
necessary: 
o "Stop": TermLinx latches signal "PLC stop transaction"; the PLC should 

stop the pump and close valves, and acknowledge by clearing the signal. 
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o "Start": TermLinx issues the same "request enable" signal as initially; the 
PLC responds in the same manner. A "start" from the HMI should not 
start the pump; a driver should confirm the start by pressing a "Start" 
(Green) button at the island. 

"Start" (Green) and "stop" (Red) commands may also be issued from buttons 
at the island. The PLC must latch signals "xqv island start" and "xqv island 
stop" respectively; TermLinx responds to the PLC through signals "PLC 
request enable transaction" and "PLC stop transaction" respectively. 
Pressing the Start or Stop buttons at the island is identical to pressing "start" 
or "stop" at the HMI, except that the Start button should not be operational 
(and not signal "xqv island start") if a transaction has not been authorized 
(through an initial "start" handshake), and otherwise may start the pump 
(which should not be available at the HMI). 

Important: For an island whose primary batch controller is another device such as an AccuLoad, 
"start" and "stop" commands issued at the device are not intercepted by TermLinx; PLC detection 
of such commands must rely on connection of appropriate signal lines from the device to the PLC. 

5 The transaction may be ended either by the PLC (for example, when the 
batch size requested has been reached) or by the HMI. The HMI will not 
allow the transaction to end while status "busy in sequence" is on. This allows 
the transaction to be properly terminated in the physical sense by the PLC 
before being terminated in the financial or authorization sense by the Driver. 

When the PLC ends a transaction, it signals TermLinx by latching signal "xqv 
post transaction", and releases any internal "transaction in progress" state. 
When TermLinx ends a transaction (for example, from the HMI "end" button), 
TermLinx latches "xqv post transaction" (signaling itself of the termination), 
and also latches "PLC end transaction" to signal the PLC to release any 
internal "transaction in progress" state. The PLC should respond by 
unlatching the "PLC end transaction", so that it can detect the signal's 
occurrence at the end of the next transaction, although TermLinx itself does 
not require the signal to be acknowledged. 
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5.2 Run TermLinx from Any HMI 

You can set up TermLinx to run from any HMI. If you selected the "RSView 
Template" feature during installation and your HMI is RSView, much of the work 
has been done for you.  

To run TermLinx from within your HMI application: 
1 Create an HMI form with a command button named "cmdTermLinx".  The 

operator will push this button to log into the TermLinx GUI.  
2 Add to your project a reference to:  

o TermLinx Overview, XYZ, v 4.0.0 (or whichever subsequent version is 
available), where "XYZ" identifies the TermLinx overview appropriate for 
your site.  There can be only one TermLinx overview in use at a site; if 
you have multiple references to choose from, BE SURE that your HMI 
application includes only one such. 

3 Drop the VBA script that follows into the form. 
4 Compile and build your HMI application. 
5 Ensure that there exists a System Environment variable called 

"TermLinx_Embedded" (without the quotes) whose value is the complete 
command line for starting your HMI application.  (If you selected the 
"RSView" feature during TermLinx installation, this variable is already set up 
to run the template RSView project that you installed -- see the TermLinx 
startup command file "TermLinx.cmd" for more information.) 

VBA Script  
Dim clsTermLinx As clsTlnxOvrw  ' class for TermLinx interface 
 
Sub Form_Load() 
' called when the HMI form is loaded 
  On Error Resume Next 
  If clsTermLinx Is Nothing Then 
    Set clsTermLinx = New clsTlnxOvrw ' create an instance of the class 
  End If 
End Sub 
 
Sub Form_Unload() 
' called when the HMI form is unloaded 
  On Error Resume Next 
  Call clsTermLinx.TermLinxDeactivate ' unload forms of class instance 
  Set clsTermLinx = Nothing  ' release the class instance 
End Sub 
 
Sub cmdTermLinx_Click() 
' called when the operator pushes the <cmdTermLinx> button of the HMI form 
  On Error Resume Next 
  DoEvents 
  Call clsTermLinx.TermLinxActivate ' show forms of class instance 
End Sub 
 
' End VBA_OVRW.txt 
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5.3 PLC Implications for an AccuLoad Batch Controller 

 The handshake in step 1 above is required for all islands; the PLC is the final 
arbiter in the transaction authorization sequence. The PLC test program 
OP_SIM_2 demonstrates the minimum ladder required for implementing step 
1 for each of four islands. 

 The PLC may at its option comply with the requirements/suggestions in steps 
2 and 3 in order to implement station management and control functions that 
are not available, or not imported from the AccuLoad itself. The PLC status 
bits referred to in step 3 are interpreted by TermLinx even for an AccuLoad 
island, and therefore may be used for additional control, but they are not 
strictly necessary because TermLinx also examines similar bits in the batch 
controller status word maintained by the AccuLoad driver. 

 TermLinx does not permit "start" and "stop" commands to be issued at the 
HMI for an AccuLoad island, regardless of the setting of the relevant 
configuration option, therefore step 4 is not currently applicable. 

 TermLinx also does not permit the HMI to issue the "end" command for an 
AccuLoad island; instead, this function is performed automatically by the 
AccuLoad upon preset exhaustion, or by the Driver pressing the "print" key. 
When the AccuLoad senses transaction termination by either of these 
methods, it issues the two signals referred to in step 5. 

Notes: 
1 Signal names in this document have the form "xqv ..." or "PLC ...". These 

symbols do not actually occur in the tag descriptors produced by TermLinx 
Configuration Manager. The prefix represents the consumer of the signal. For 
example, "Xqv" represents the TermLinx executive. 

2 The signal "xqv post transaction" is the signal issued for a "normal" 
transaction termination, in which any unconsumed residue of the preset is 
discarded. When such a residue is to be saved for later discharge as a "split" 
transaction, the proper signal is "xqv split transaction". 

Except for the disposition of any preset residue, the handling of each of these 
two signals is Identical. 

 

5.4 Sample Ladder 

The sample ladder included with the installation provides a starting point to 
customizing and implementing ladder logic for your own application. The ladder 
is written in RSLogix 5000 for ControlLogix processors.   

You can find the sample ladder in the Samples folder in your TermLinx 
installation folder.  

Due to the way the Rockwell Automation ControlLogix processor handles internal 
memory and user tags, the exact address of each location is irrelevant. However, 
TermLinx configuration generates very specific tags for this processor and 
identifies blocks of tags with reference to numbered loading/unloading islands. 
PLC Interface File Structure & Program Tags in the TermLinx Database Manager 
Manual documents the complete file structure for the gate control file and the 
operational loading island files. 
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5.5 Ladder Logic Diagram 
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6 Rarely Used OPACTS Features 

6.1 Starting the OS-9/Win32 Batch Controller 

Note: The information in this section applies only to OPACTS users. If you are running TermLinx, 
you do not need to be concerned with the details in this section.  

Start one instance of the OS-9 AccuLoad batch controller program for each serial 
port connected to an AccuLoad multi-drop loop. Different AccuLoad models may 
be mixed on a single loop. 

The command line syntax is: 
ACCUOPCT  <baud> [] [&] 

where: 
The serial port number "n", for COMMn (OS-9) or COMn (Win32). 

aud> The communications baud rate, 300 thru 38400. 

The communications parity ("N", "E", or "O") and data bits ("7" or "8") written as a 
single token. Default is "E7". 

 [OS-9 only] An optional literal "&" for placing the process into the background; OS-9 
permits only one foreground process. ProSoft recommends that one process (the last) 
remain in foreground. 

ACCUOPCT requires a configuration file (.OPS file) that contains information 
pertaining to its CoPro port. TermLinx Configuration Manager creates this file for 
you at the same time as it creates the TermLinx binary configuration file (.OPK). 

Important: The CoPro will use the first instance of an .OPS file to read its configuration 
information. There should only be one .OPS file stored on the CoPro at any time, otherwise 
operation of the CoPro may not be as intended. 
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7 ProSoft TermLinx Agreement 

In This Chapter 

 SCHEDULE A: GENERAL TERMS AND CONDITIONS.......................55 

 SCHEDULE B: SOFTWARE LICENSE.................................................60 

 SCHEDULE C: MAINTENANCE AND SUPPORT ................................61 

 SCHEDULE D: INSTALLATION SERVICES.........................................63 

 
 

7.1 SCHEDULE A: GENERAL TERMS AND CONDITIONS 

7.1.1 DEFINTIONS 

1 "Confidential Information" shall mean any information of the Disclosing Party 
and includes, without limitation, any business, marketing, technical and 
scientific information, trade secrets, processes, designs, data, formula, plans, 
prototypes, specification, know-how, improvements, inventions (whether 
patentable or not), techniques, software, source code, customer lists, 
research, business opportunities, agreements and other information whether 
or not related to or arising from the activities contemplated in this Agreement 
and which may be in any form or medium and whether or not designated as 
confidential (or like designation). Notwithstanding the forgoing, Confidential 
Information shall not include any information that (a) is in the public domain 
without such disclosure being as a result, directly or indirectly, of a breach of 
the obligations of confidence, secrecy or non-use by the Receiving Party or; 
(b) was previously known to the Receiving Party, reasonable proof of which 
lies upon the Receiving Party; or (c) was received by the Receiving Party 
without any obligation of confidentiality from a source (other than the 
Disclosing Party) lawfully having possession of such information; or (d) is 
released or disclosed to the public by the Disclosing Party or by its conduct; 
or (e) is required to be disclosed by operation of law. 

2 "Date of Order" shall mean the Date of Order as set out in an Order. 
3 "Disclosing Party" shall mean a party who provides Confidential Information 

to the Receiving Party under this Agreement. 
4 "Documentation" shall mean user and technical documents relating to the 

Equipment or Software delivered to Licensee by Licensor. 
5 "Equipment" shall mean the computer and other equipment set out in an 

Order and other ancillary equipment delivered to Licensee. 
6 "Installation Fee" shall mean the Installation Fee as set out in an Order. 
7 "Intellectual Property" shall mean any intellectual property, including without 

limitation, patents, trademarks, copyright and industrial design. 
8 "Maintenance Fee" shall mean the Maintenance Fee as set out in an Order. 
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9 "Order(s)", the form of which shall be substantially as attached in Schedule E. 
10 "Receiving Party" shall mean a party receiving Confidential Information from 

the Disclosing Party under this Agreement. 
11 "Release" shall mean a version of the Software delivered to Licensee 

containing minor functional enhancements, modifications, extensions, error 
corrections or bug fixes. Releases do not include a major addition to the 
functionality of the Software. 

12 "Services" shall mean any services provided by Licensor to Licensee under 
this Agreement including maintenance and support and installation services. 

13 "Software" shall mean software programs, including Releases, in object code 
format only, set out in an Order or developed for Licensee pursuant to any 
Services. 

14 "Software License" shall mean the terms and conditions set out in Schedule 
B. 

15 "System" shall mean the Software and Equipment. 
16 "System Price" shall mean the System Price for the Equipment and Software 

as set out in an Order. 
17 "Term" shall mean from the Date of Order, continuing in perpetuity. 
18 "State" shall mean the United States. 
19 "Territory" shall mean Canada. 

7.1.2 PRICE, PAYMENT AND ORDERS 

1 All amounts payable under this Agreement, including without limitation the 
System Price, Maintenance Fees and Installation Fees, shall be paid by 
Licensee to Licensor within thirty (30) days of receipt of an invoice. 

2 Licensee shall pay all taxes, duties, charges, assessments and all other 
required remittances of any kind (excluding taxes based solely on Licensor's 
income) imposed by any federal, provincial, state or local government which 
arise and become due as a result of any transaction hereunder or the use of 
the Equipment or Software or the provision of any Service. 

3 Any offer to license software or procure equipment or services from Licensor 
shall be done pursuant to an Order. All Orders, when executed by the parties, 
shall be subject to the terms and conditions of this Agreement and shall 
become part of this Agreement. In no event will the terms or conditions of 
Licensee's purchase orders or other documents vary or add to the terms and 
conditions set out in this Agreement. 

7.1.3 TITLE 

1 Licensor (or its suppliers) retain all right, title and interest in and to the 
Software including all Intellectual Property embodied therein. All copies of the 
Software shall remain the property of Licensor or its suppliers. 

2 Licensee shall become the owner of the Equipment on delivery and 
installation. 
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3 Licensee hereby acknowledges and agrees that the Software constitutes and 
contains valuable proprietary products and trade secrets of Licensor. 
Accordingly, Licensee agrees to treat (and take sufficient precautions to 
ensure that its employees and agents treat) the Software as Confidential 
Information in accordance with the confidentiality provisions set out in Section 
4. 

7.1.4 CONFIDENTIAL INFORMATION 

1 A Receiving Party shall be bound by an obligation of confidence to the 
Disclosing Party in respect of any Confidential Information disclosed by the 
Disclosing Party or on its behalf. In respect of such Confidential Information, 
the Receiving Party shall not: (a) disclose, either directly or indirectly, any 
such Confidential Information, or any part thereof, other than to its employees 
who have a need to know the Confidential Information (b) shall not use any 
such Confidential Information, or any part thereof for any purpose except as 
specifically contemplated in this Agreement and (c) shall not make any copies 
of any Confidential Information except as required to fulfill the obligations and 
to exercise the rights granted in this Agreement. The Software shall only be 
copied for the purposes of installing it on one computer and to make one 
back-up copy. 

2 The parties agree that the terms and conditions of this Agreement are 
confidential and that neither party shall disclose the contents of this 
Agreement without the prior written consent of the other party or except as 
required by law. Notwithstanding the forgoing, the general relationship of the 
parties (and not the specific terms) shall not be treated as confidential and 
the disclosure of same is permitted. 

7.1.5 TERM 

1 The term of this Agreement shall be the Term, unless terminated earlier as 
provided herein. 

2 This Agreement and the licenses granted herein may be terminated by the 
non-defaulting party if any of the following events of default occur: (1) if a 
party materially fails to perform or comply with this Agreement or any 
provision hereof; (2) if a party fails to comply with the provisions of Section 2 
(Price, Payment and Orders) or Section 4 (Confidential Information); (3) if a 
party becomes insolvent or admits in writing its inability to pay its debts as 
they mature or makes an assignment for the benefit of creditors; (4) if a party 
files a petition for bankruptcy, receivership statute or the like, as they now 
exist or as they may be amended, is filed by a party; or (5) if such a petition is 
filed by any third party or an application for a receiver is made by anyone and 
such petition or application is not resolved in favor of the party within ninety 
(90) days. 

3 Termination shall be effective thirty (30) days after notice of termination is 
delivered to the defaulting party if the defaults have not been cured within 
such thirty (30) day period. 

4 Upon termination of this Agreement, Licensee shall cease and desist all use 
of the Software. 
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5 Notwithstanding the termination of the Agreement, Sections 2, 3, 4, 6 and 7 
shall survive such termination and remain in force. All other rights and 
licenses granted hereunder shall be extinguished upon termination. 

6 Irrespective of the reason for termination, all payments made by Licensee to 
Licensor hereunder are non-refundable. 

7.1.6 WARRANTIES AND LIMITATION OF LIABILITY 

1 Licensor warrants that the Equipment will be free of manufacture's defect for 
a period of 120 days from the date of installation and warrants that the 
Software will have been installed on the Equipment. 

2 Licensor does not represent or warrant that all errors in the System or 
Services can or will be corrected. 

3 THE SOFTWARE AND SERVICES ARE BEING PROVIDED STRICTLY ON 
AN "AS IS" BASIS. EXCEPT AS OTHERWISE EXPLICITLY SET OUT 
HEREIN LICENSOR EXPRESSLY DISCLAIMS ANY AND ALL 
WARRANTIES AND CONDITIONS CONCERNING THE EQUIPMENT, 
SOFTWARE AND SERVICES, INCLUDING ANY AND ALL WARRANTIES 
AND CONDITIONS OF DESIGN, MERCHANTABILITY AND FITNESS FOR 
ANY PARTICULAR PURPOSE, PERFORMANCE AND ANY AND ALL 
WARRANTIES AND CONDITIONS THAT MIGHT OTHERWISE ARISE 
DURING THE COURSE OF DEALING, USAGE OR TRADE AND THOSE 
WHICH MAY BE IMPLIED BY LAW. THIS AGREEMENT SETS OUT THE 
ENTIRE EXTENTS OF ALL WARRANTIES IN RESPECT OF THE 
EQUIPMENT, SOFTWARE AND SERVICES AND NO AGENT OF 
LICENSOR IS AUTHORIZED TO ALTER THE WARRANTY OBLIGATIONS 
OF LICENSOR. ALL ALTERATIONS SHALL BE IN WRITING. 

4 Licensee acknowledges that it has or will have independently determined that 
the Equipment, Software and Services meet its business requirements and 
that it shall not rely on any representation made by Licensor as to the 
suitability of the Equipment, Software or Services for nay particular purpose. 

5 UNDER NO CIRCUMSTANCES SHALL LICENSOR BE LIABLE FOR 
INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR 
LOSS OF PROFITS, INTERRUPTION OF BUSINESS OR RELATED 
LOSSES OR EXPENSES INCURRED BY LICENSEE WHICH MAY ARISE 
OUT OF THE USE OR FAILURE TO USE THE EQUIPMENT OR 
SOFTWARE OR ANY FAILURE IN THE SERVICES, WHETHER OR NOT 
LICENSOR WAS TOLD OF THE POSSIBILITY OF SAME. 

6 LICENSOR'S TOTAL MAXIMUM AGGREGATE LIABILITY UNDER THIS 
AGREEMENT AND THE LICENSE AND USE (AND INABILITY TO USE) OF 
THE EQUIPMENT AND SOFTWARE AND IN RELATION TO THE 
SERVICES UNDER ANY AND ALL OTHER CIRCUMSTANCES, ARISING 
IN ANY MANNER WHATSOEVER, SHALL BE LIMITED TO FIVE HUNDRED 
U.S DOLLARS (US $500.00). THIS LIMITATION OF LIABILITY IS 
CUMULATIVE AND NOT PER INCIDENT. 
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7 Licensor shall defend Licensee in any suit or proceeding or threatened suit or 
proceeding brought against Licensee based solely on a claim that the 
Software infringes any enforceable copyright, trade secret or trademark right 
in the State or Territory of any third party but only if: (a) Licensee shall notify 
Licensor in writing of any such suit or proceeding or threatened suit or 
proceeding promptly after Licensee first learns of same; and (b) Licensee 
shall provide, at no cost, such reasonable assistance and co-operation as 
Licensor may reasonably request from time to time in connection with the 
defense of same. Licensor may either defend or settle such claim. Licensor 
shall have complete control over any such suit or proceeding including, 
without limitation, the right to settle on behalf of Licensee on any terms 
Licensor deems desirable (in the sole exercise of its discretion) so long as it 
is at no cost to Licensee. Licensee shall have the right to be independently 
represented by counsel of its own choice and at its own cost. Licensee shall 
not settle any such claim without Licensor's prior written consent. 

8 If the use of any of the Software is enjoined (or is likely to be enjoined in the 
reasonable opinion of Licensor) as a result of any action or claim, Licensor 
shall, at its sole option and expense either: (a) obtain for Licensee the right to 
continue using the Software; or (b) modify the Software so that it no longer 
infringes; or (c) provide Licensee with reasonable alternate software, as 
applicable, providing substantially similar features, functions and capability; or 
(d) refund to Licensee the System Price (less an amount for depreciation on a 
straight line basis over five years) paid by Licensee for the System and 
Licensee shall cease using the System. 

9 Licensor shall have no liability hereunder for infringement claims based upon 
modifications made to the Equipment or Software by or on behalf of 
Licensee, the combination of the Equipment or Software with any other 
software, equipment, system or process or the use of the Equipment or 
Software other than as described in the Documentation. 

10 The foregoing infringement provision sets out the entire liability and 
obligations of Licensor and the sole remedies of Licensee in respect of any 
claim that the Equipment or Software infringes any third party rights, including 
patent rights. 

11 Other than instances where Licensor is obligated to indemnify Licensee 
herein, Licensee shall indemnify and hold harmless Licensor from and 
against any claims, demands or causes of action whatsoever, and shall 
defend or shall defend or settle all claims and actions brought against 
Licensor by a third party arising out of or related to Licensee's use of the 
Equipment, Software or Documentation, howsoever such claim or action shall 
have occurred or arose. 

12 Licensee hereby agrees that it is responsible for implementing procedures 
and systems to protect its operations and data as is prudent to prevent and 
mitigate against the loss or damage to same in the event of errors or a 
malfunction in the Equipment or Software. Under no circumstances shall 
Licensor incur any liability due to Licensee's failure to implement the forgoing. 
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7.1.7 GENERAL 

1 Licensee shall have no right to transfer, assign or otherwise dispose of its 
rights or obligations hereunder without the prior written consent of Licensor. 
Licensee shall, however, have the right to transfer this Agreement in the 
event of a sale of all or substantially all of its assets or the business 
operations in which the System is used. 

2 This Agreement shall be governed, construed and enforced in accordance 
with the laws of the State of California, without reference to conflict of laws 
principles. Any dispute arising out of this Agreement or in relation to the 
Equipment, Software or Services shall be adjudicated in the courts in 
California, U.S.A. Notwithstanding the forgoing, either party may apply to any 
court of competent jurisdiction for injunctive relief. 

3 The Licensor and Licensee hereunder are independent contractors and 
nothing contained in this Agreement shall be construed to constitute the 
parties otherwise. 

4 If any provision of this Agreement is held to be invalid by a court of competent 
jurisdiction, then the remaining provisions shall remain in full force and effect. 

5 The failure of either party to enforce at any time any of the provisions of this 
Agreement shall not be deemed to be a waiver of the right of either party to 
enforce the same or a different provision in the future. 

6 The nonperformance by either party of an obligation hereunder shall be 
excused to the extent that performance is rendered impossible by strike, fire, 
flood, governmental acts or orders or restrictions, failure of suppliers, or any 
other reason where failure to perform is beyond the control and not caused 
by the negligence or neglect of the non-performing party. Financial difficulty is 
excluded. 

7 This Agreement constitutes the entire agreement between the parties and 
supersede all previous agreements and representations, oral or written, 
relating to the subject matter of this Agreement. This Agreement may not be 
modified or amended except in writing signed by a duly authorized 
representative of each party. 

 

7.2 SCHEDULE B: SOFTWARE LICENSE 

7.2.1 LICENSE 

1 Subject to the terms and conditions of the Agreement and this Software 
License, Licensor hereby grants to Licensee a non-exclusive, non-
transferable license for the Term, without right of sublicense, to install and 
use the Software in the State or Territory for Licensee's internal business 
purposes only. 

2 Licensee shall have no rights in the Software other than as specifically set out 
herein. Licensee shall not create derivative works of the Software or permit 
any third party to use the Software or shall Licensee operate the Software on 
behalf of a third party. Licensee shall not reverse engineer, de-compile or 
otherwise attempt to derive the source code of the Software. 
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3 Licensor may attend the office of Licensee to audit Licensee's operations to 
ensure Licensee's use of the Software is in compliance with the terms of this 
Agreement. All operational audits will be conducted during regular business 
hours with reasonable notice. 

4 Specific customization development performed by ProSoft Technology, Inc. 
on behalf of a Customer is owned by ProSoft Technology, Inc. and Licensed 
by the Customer. 

 

7.3 SCHEDULE C: MAINTENANCE AND SUPPORT 

7.3.1 DEFINITIONS 

1 "Maintenance and Support" shall mean that Licensor will provide: 

a) Releases, as and when Licensor makes the same generally available to 
its other customer. Release includes system changes and bug fixes; and 

b) Major upgrades are subject to additional charge; and 
c) Basic Support or 24 / 7 Support as set out in an Order. 

2 "Onsite Support Fee" shall mean two hundred and seventy-five dollars (US 
$275.00) per man-hour. 

3 "Basic Hours of Support" shall mean Monday through Friday, excluding 
statutory holidays in Bakersfield, California, 8:00 a.m. to 5:00 p.m., Pacific 
Standard Time. 

4 "Current Version" means the most recent version of a Release, plus the prior 
Release. 

5 "Basic Support" shall mean Telephone or email support with respect to the 
Current Version, during the Basic Hours of Support. Such telephone support 
shall include (i) clarification of the functions and features of the Current 
Version, (ii) clarification of Documentation and (iii) error verification, analysis 
and correction. 

6 "24 / 7 Support" shall mean the Basic Support and access outside of the 
Basic Hours of Support to support personnel via message pager for 
urgent/emergency situations. 

7.3.2 GENERALLY 

1 For so long as Licensee is current in the payment of all fees, including the 
System Price and the Maintenance Fees, Licensor shall provide the 
Maintenance and Support to Licensee. 

2 Licensee shall supply the Licensor with the following items: 
o Current PLC ladder logic responsible for interaction with TermLinx 

system. 
o Contact information for local on-site personnel, or Systems Integration 

Company responsible for the maintenance and operation of the TermLinx 
system. 

o Current system diagram pertaining to the TermLinx system. 
o Electronic access to the TermLinx system so that Maintenance and 

Support can be provided remotely. Failure to provide access may limit 
support. 
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3 During the term of the Maintenance and Support, Licensor shall use its 
reasonable commercial efforts to correct any reproducible programming 
errors in the Current Version. Upon identification of any programming error, 
Licensee shall notify Licensor of such error and provide Licensor with a 
description of the problem and any reasonable assistance as requested by 
Licensor. Licensor shall use commercially reasonable efforts to correct such 
errors in the Current Version. 

4 Releases may be provided by electronic delivery through an ftp server over 
the Internet. Licensor will provide Licensee with notice of a new Release by 
e-mail. Licensee is responsible for installing any Release or alternatively, at 
Licensee's request, Licensor will install the Release at the Installation Fee. 

5 Technical Support contact information is as follows: 

By Phone: 661.716-5100 or 800-326-7066 

By Email: support@prosoft-technology.com (mailto:support@prosoft-
technology.com) 

7.3.3 MAINTENANCE FEES 

Licensee shall pay to Licensor the Maintenance Fee on the Date of the Order 
and on every yearly anniversary thereafter. The Licensor may increase the 
Maintenance Fee by providing sixty (60) days notice of same prior to the 
Maintenance Fee becoming due in any year. 

7.3.4 EXCLUSIONS 

1 Licensor shall not be responsible for correcting any errors arising out of (i) the 
operation of the Software in an environment other than as set out in the 
Documentation; (ii) any alterations of or additions to the Software performed 
by parties other than Licensor or under the direction of Licensor; or (iii) use of 
the Software in a manner other than as contemplated in the Documentation. 

2 Licensor has no obligations to provide Maintenance and Support other than in 
respect of the Current Version. 

3 If any Maintenance and Support is required to be delivered other than from 
the offices of Licensor, Licensee shall pay the Onsite Support Fee (including 
travel time) and Licensor's reasonable travel, subsistence and other 
expenses where the same have not already been provided by Licensee. 

4 Within thirty (30) days of each month end Licensor shall submit an invoice for 
any onsite support which it is entitled to charge and any expenses incurred. 
All invoices shall be accompanied by such personnel timesheets, vouchers, 
receipts and other materials as reasonably required by written notice by 
Licensee. Licensee shall pay the amount of said invoice within fourteen (14) 
days after receipt thereof. 

5 Under no circumstances does Licensor warrant or represent that all errors 
can or will be corrected. 

mailto:support@prosoft-technology.com
mailto:support@prosoft-technology.com
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7.3.5 TERM AND TERMINATION 

1 The term of Maintenance and Support shall take effect on the Date of the 
Order and shall remain in effect for one year. The term of Maintenance and 
Support shall automatically renew at the end of each term for an additional 
term of one (1) year unless either party notifies the other of termination at 
least thirty (30) days prior to the end of the then current term. 

 

7.4 SCHEDULE D: INSTALLATION SERVICES 

7.4.1 DEFINITIONS 

1 "Installation Services" shall mean: 

a) the installation of the Software; 
b) configuring the Software and Equipment; and 
c) delivering the Equipment to the Licensee's location 

7.4.2 SCOPE OF SERVICES 

1 Licensor shall provide the Installation Services. 
2 Licensor will retain the sole and exclusive right to control the manner and 

means by which the Installation Services are performed. Licensor may 
subcontract the performance of the Installation Services. 

7.4.3 LICENSEE'S DUTIES AND RESPONSIBILITIES 

1 Licensee shall make available in a timely manner at no charge to Licensor all 
of its systems and resources reasonably needed by Licensor to perform the 
Installation Services. 

7.4.4 RELATIONSHIP OF PARTIES 

1 Licensee agrees that for a period of six (6) months following the provision of 
any Installation Services, it will not make any offer to engage any employee 
or contractor of Licensor as an employee or contractor of Licensee. 

7.4.5 FEES 

1 Any installation service required will be billed at the Installation Fee per hour 
(including travel time). Licensee shall pay to Licensor the Installation Fee. 
Licensor shall invoice Licensee on a biweekly basis in arrears. 

7.4.6 EXPENSES 

1 Licensee shall reimburse all reasonable travel and other related expenses 
incurred by Licensor in the performance of the Installation Services. 
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7.4.7 TERM AND TERMINATION 

1 The terms and conditions of this Schedule will take effect on the Date of the 
Order and will remain in effect until all of the Installation Services have been 
completed, unless terminated earlier in accordance with the Agreement. 
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